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An LC meter is a handy tool for any electronics 

hobbyist.   There are ready-built devices which you 

Ŏŀƴ ǇǳǊŎƘŀǎŜΣ ōǳǘ ǿƘŀǘΩǎ ǘƘŜ Ŧǳƴ ƛƴ ǘƘŀǘΚ  ¸ƻǳ can 

make your own meter for less money and with 

better accuracy.  Read on if you are interested in 

building your own LC meter based on the famous 

AADE design. 

 

Introduction 

Several DIY meters are available on the web.  One of the most accurate and widely acclaimed was 

designed and sold by Neil Hecht and his company AADE (Almost All Digital Electronics).  Neil passed 

away in 2015 but his design lives on. 

An AADE-ƛƴǎǇƛǊŜŘ ŘŜǎƛƎƴ ǿŀǎ ǊŜŎŜƴǘƭȅ ƛƳǇƭŜƳŜƴǘŜŘ ōȅ άŎƻǊŜ²ŜŀǾŜǊέΣ ǳǎƛƴƎ ŀƴ !¢ƳŜƎŀону ŦƻǊ ǘƘŜ a/¦ 

and a Nokia 5110 LCD for the display.   The documentation for his project, including links to his videos, is 

found on his GitHub page at: https://github.com/coreWeaver/LC-Meter.   

I decided to design my own.  I wanted a meter that would be easy to 

build, using through-hole components, and easy to program using the 

Arduino IDE.  This document describes, step-by-step, how to build 

your own meter.  I believe in starting small and testing as I go.   

 

Not a Kit. 

Forgive me for starting these notes with a disclaimer:  this is not a kit, 

I am not selling anything, and there is no guarantee of success or 

suitability for any particular purpose.   Still interested?  
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Bill of Materials. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Additional miscellaneous components:  AVR external programmer, LC Meter PCB, 9VDC Adapter, 8pin 

DIP sockets for the LM311 IC, 28-pin DIP socket for the ATmega328, 4-pin and 8-pin male headers for 

the display module, 4 pin and 8-pin female headers for the display socket.  

Qty Reference(s) Value Description 

1 BZ1 Piezo Buzzer TDK PS1240P02BT 

1 C1 1000pF WIMA Film, 2.5% 

1 C2 1000pF WIMA Film, 1% 

3 C3, C6, C7 10uF Electrolytic, 16V 

1 C4 10uF Tantalum, 16V 

1 C5 0pF /ŜǊŀƳƛŎΣ лΦмέ ƻǊ лΦнέΣ not fitted 

2 C9, C10 22pF Ceramic disc, 0.1" 

2 C11, C12 100nF MLCC, 0.1" 

1 D1 BAT42 Schottky diode 

1 D2 1N4148 small signal diode 

2 D3, D4 3mm LED D3 yellow, D4 blue 

4 H1, H2, H3, H4 Mounting Hole M3 hardware 

1 J1 Red Probe CalTech CT3151V1-2 

1 J2 Black Probe CalTech CT3151V1-0 

1 J3 DC Barrel Jack CUI PJ-102AH  

1 J4 9V Battery Header not fitted 

1 J5 ICSP Header 2x3 male, 0.1" 

1 J6 UART Header мȄо ƳŀƭŜΣ лΦмέΣ not fitted 

2 J7, J8 Supports A & B мȄп ƳŀƭŜΣ лΦмέΣ not fitted 

1 K1 DPDT Relay  Kemet UA2-5NE or equiv. 

1 K2 SPST Reed Relay Medex SIL05-1A72-71L or equiv. 

1 L1 82uH Fixed Inductor, 5% 

1 Q1 2N3904 TO-92 NPN 

8 R1, R9-R11, R14-R17 1K 0.25W, 5% 

1 R2 120R 0.25W, 5% 

3 R3, R4, R13 10K 0.25W, 5% 

3 R5, R6, R7 100K 0.25W, 5% 

1 R8 47K 0.25W, 5% 

1 R12 6.8K 0.25W, 5% 

1 R18 68R 0.25W, 5% 

2 S1, S2 SPST Switch 6mm TACTILE 

1 SW1 SPDT Slide Switch OS102011MA1QN1 

1 U1 L4931CZ50-AP IC REG LINEAR 5V 250MA TO92-3 

1 U2 LM311 IC DIP-8 

1 U4 ATmega328P_DIP28 IC 8-bit MCU 

1 U5 TFT Display MSP1803, 128x160 pixel  

1 Y1 16MHz crystal HC49-U 



The PCB.  

To order a circuit board from a manufacturer you must 

provide a ŘƛƎƛǘŀƭ ǎŜǘ ƻŦ ŘŜǎƛƎƴ ŦƛƭŜǎΣ ŎŀƭƭŜŘ ΨGerbersΩΦ   ¸ƻǳ 

can obtain the Gerbers on my GitHub account.  

Almost all board fabricator websites allow Gerber-file 

ǳǇƭƻŀŘǎΦ  /ƘƻƻǎŜ ǘƘŜ ƳŀƴǳŦŀŎǘǳǊŜǊ ȅƻǳ ƭƛƪŜΦ   LΩǾŜ ǳǎŜŘ 

OSH Park (USA, excellent quality) in the past and have 

been very satisfied.  For this project I used JLCPCB (China, 

prototype quality).   Choose the default 2-layer options, 

get your quote, and choose whatever shipping option you 

want.   At JLCPCB I paid $2.00 + shipping for a set of 5 

boards. 

All components are mounted on the front face of the PCB. 

Refer to the interactive BOM to identify the location for 

each part. 

 

Step 0: Preparation. 

Obtain the PCB and parts listed above.  In addition, you 

will need a decent soldering iron, solder, an external 

programmer for your microcontroller (such as an AVR-ISP 

or USBtinyISP), a digital multimeter, and a 6V-10V DC 

power supply with barrel connector (2.1mm center pin positive).  You should be familiar with soldering 

and have successfully kitted other projects using ICs and other through-hole components.  You should 

have sufficient lighting, magnification, and workspace area. 

¢Ƙƛǎ ōǳƛƭŘŜǊΩǎ ƎǳƛŘŜ Ƴŀȅ ŎƘŀƴƎŜ ŦǊƻƳ ǘƛƳŜ ǘƻ ǘƛƳŜΦ  wŜŦŜǊ ǘƻ ǘƘŜ Ƴƻǎǘ ǊŜŎŜƴǘ ǾŜǊǎƛƻƴ ŀǘΥ 

http://w8bh.net/LCmeter_BuildersGuide.pdf. 

As I mentioned earlier, I believe in starting small.  Build the smallest something that you can and test it.  

5ƻƴΩǘ ŦƻǊƎŜ ŀƘŜŀŘ ǳƴǘƛƭ ȅƻǳ ŀǊŜ ǎǳǊŜ ŜǾŜǊȅǘƘƛƴƎ ƛǎ ǿƻǊƪƛƴƎΦ  ²Ŝ ǿƛƭƭ ōǳƛƭŘ ŀƴŘ ǘŜǎǘΣ ǎǘŜǇ ōȅ step. 

These instructions assume that you are comfortable using the Arduino IDE, and that you will program 

the microcontroller using the onboard 6-pin ICSP header.  However, you may program the MCU in any 

manner that that suits you. 

Take a moment to familiarize yourself with the PCB.   In general, the build will start near the top of the 

board and work downward.  The board has 5 main sections:  the power supply, the MCU, the display, 

the control circuit, and the oscillator.   We will tackle one section at a time and test each section with 

code and/or multimeter before moving on.   

Note: When soldering components, I recommend soldering the first pin and checking component 

alignment on the front face of the PCB before soldering the remaining pin(s).  

https://en.wikipedia.org/wiki/Gerber_format
https://github.com/bhall66/LC-meter/tree/main/PCB
https://oshpark.com/
https://jlcpcb.com/
http://w8bh.net/LCmeter_BOM.html
http://w8bh.net/LCmeter_BuildersGuide.pdf


Step1:  Build the power supply. 

You will use the following components:  

J3, SW1, D1, C3, C6, U1. 

Install 

o Switch SW1. 

o Diode D1, with the dark band facing 

left. 

o Electrolytic caps C3 and C6, with the 

white band (-) facing downward. 

o 5V regulator U1, flat side facing up. 

o DC barrel connector J3. 

 

o Double-check: diode band LEFT, regulator flat face UP, capacitor white bands DOWN. 

 

Test 1:  After installing these components, apply 9VDC via the barrel connector (center pin positive) and 

slide the switch right to the on position.  Use your DMM to confirm +5V between the pin adjacent to the 

ƭŀōŜƭ ά¦рέ and the pin ƭŀōŜƭƭŜŘ άDb5έ, as shown in the photo below.  Disconnect Power.  If you did not 

observe the correct voltage, please refer to the troubleshooting guide.  

 



The circuit you just built provides regulated 5V power to board.  Here is the schematic: 

 

Power is provided through the DC barrel connector, J3.  There is also an optional power input at J4.  

Note that when a power plug is inserted into J3, the mechanical connection between pins 2 and 3 is 

broken, removing power souce J4 from the circuit.  This internal switch prevents current from J3 flowing 

into J4, and vice versa. 

Diode D1 provides protection against reversed polarity.  Voltage loss across the diode is minimized by 

using a Schottky diode, rather than a standard 1N4007 power diode. 

Voltage regulator U1 can handle an input voltage of 20V, and supply up to 300mA of current at 5V.    

Capacitors C3 and C6 are required for regulator stability.  The capacitor values are non-critical:  values as 

low as 0.1uF for C1 and 2.2uF for C6 will provide adequate regulator stability. 

Resistors R3 and R4 provide a way of measuring the voltage input.  They form a voltage divider, 

providing a voltage on pin VBAT that is one half of the unregulated input voltage.  The microcontroller 

cannot tolerate voltages greater than 5V on its input pins, therefore power input for this device is 

limited to 10V.  Could you increase R3 to allow higher input voltages?  Of course!  Just be mindful of 

¦мΩǎ ǇƻǿŜǊ ŘƛǎǎƛǇŀǘƛƻƴΦ 

Get ready to build and program your own microconroller. 

  

https://en.wikipedia.org/wiki/Voltage_divider


Step 2a: Build the microcontroller circuit. 

For this step you will use the following 

components: J5, BZ1, C9, C10, C11, C12, U4, 

R13, Y1.  Install, from top to bottom, 

o J5, the 6-pin programming header 

o 10K resistor R13, below the header 

o Piezo BZ1 

o 100nF capacitors C11 and C12 

o 16MHz crystal Y1 

o 22pF capacitors C9 and C10 

o 28-pin socket at the position for U4, with 

the notch facing left. 

o U4, the ATmega328 microcontroller, with 

the notch facing left. 

o DOUBLE-CHECK:  U4 notch on LEFT. 

Before going further, turn the board over and 

inspect your solder joints.  Make sure that each joint is shiny and well-formed, with no solder bridging 

adjacent pads. 

 

2b.  Install the bootloader. 

The next procedure is to install the bootloader.  This may seem odd since we ŘƻƴΩǘ use the bootloader.  

However, it confirms communication between your computer and the LC meter.  It also sets the MCU 

hardware fuses, configuring the LC meter to function like an Arduino.  So, 

1. Prepare your MCU programmer ŀŎŎƻǊŘƛƴƎ ǘƻ ǘƘŜ ƳŀƴǳŦŀŎǘǳǊŜǊΩǎ instructions and connect it to your 

computer.  I use the AVRISP-mkII.  The USBtinyISP programmer is another good choice. 

2. Confirm an intact USB link between the computer and programmer.  If you are using a PC, open the 

device manager and make sure that your programmer is listed.  For example, on my PC the 

ǇǊƻƎǊŀƳƳŜǊ ŀǇǇŜŀǊǎ ŀǎ άƭƛōǳǎō-win32 devices -> AVRISP mƪLLέ 

3. Start the Arduino IDE on your computer.  From the Tools menu of the Arduino IDE, 

¶ Select Board > άArduino UNOέ 

¶ Select Programmer > AVRISP mkII (or your device) 

4. Plug the 6-wire programming cable onto to the header J5 of your LC meter, making sure that all 6 

pins are firmly seated.  If the programming cable has a red wire it will be facing LEFT toward the DC 

jack. 

5. Apply power to the LC meter, as in step 1.  Slide the switch right to the ON position.  (At this point, 

an AVRISP-ƳƪLLΩǎ LED will turn from red to green, confirming power to the board.) 

6. From the Tools menu, select ά.ǳǊƴ .ƻƻǘƭƻŀŘŜǊέ. 

7. Check the bottom of the IDE screen for any error messages.  If it says, ά5ƻƴŜ ōǳǊƴƛƴƎ ōƻƻǘƭƻŀŘŜǊέΣ 

all is well.  Red ǘŜȄǘ ǿƛǘƘ ǘƘŜ ǿƻǊŘǎ ά9ǊǊƻǊ ǿƘƛƭŜ ōǳǊƴƛƴƎ ōƻƻǘƭƻŀŘŜǊέ ǿƛƭƭ ǊŜǉǳƛǊŜ further 

investigation.  See the troubleshooting guide for suggestions. 

LC Meter Build: Step 2 

https://www.ebay.com/sch/i.html?&_nkw=avrisp+mkii
https://www.adafruit.com/product/46


 

2c.  Program the LC meter. 

If the bootloader burned successfully, compile and upload the LCM_Test2 sketch, using the IDE 

command ά¦ǇƭƻŀŘ ǳǎƛƴƎ ǇǊƻƎǊŀƳƳŜǊέ ғ/ǘǊƭҔғ{ƘƛŦǘҔ¦Φ  The sketch is working if you hear the piezo softly 

beeping.  Here is what you just programmed: 

 
void beep() {  
  tone( A3, 2000, 100);       // 2000 Hz tone for 0.1 seconds on pin A3  
  delay(200);  
}  
 
void setup() {  
}  
 
void loop(void) {          // repeat forever:  
  beep(); beep();          // two beeps  
  delay(1000);             // and a pause  
}  

This code is easiest to read from the bottom up.  Looking at the loop() routine, we see two beeps 

followed by a one-second delay.  Above that, beep() calls the standard Arduino tone() routine to emit a 

2000Hz tone for 100ms.  A3 is the MCU pin connected to the piezo element. 

The microcontroller circuit requires a few support 

components.  R13 keeps the Reset line high so that 

the MCU does not reset accidentally.  Y1, C9, and 

C10 are used to provide a 16 MHz clock.   C12 

reduces noise on the power lines, and C11 reduces 

noise on the MCU internal analog circuit. 

The programmer sends data to the MCU via 3 pins: 

MOSI, MOSI, and SCK.  The 3 remaining pins on the 

programming header are +5V, GND, and NC (no 

connection). 

bƻǿ ǘƘŀǘ ǿŜ ƘŀǾŜ ŀ ǿƻǊƪƛƴƎ ƳƛŎǊƻŎƻƴǘǊƻƭƭŜǊΣ ƛǘΩǎ 

time to add a display. 

  

https://github.com/bhall66/LC-meter/tree/main/diagnostics/LCM_Test2


Step 3: Build the display circuit. 

For this section you will use components R3, R4, R14-R17, Q2, TFT-Display.  Install 

o 10K resistors R3 and R4 

o 1K resistors R14, R15, R16, R17 

o 68-ohm resistor R18 

o 8-pin (if not already present) and 4-pin male headers on the display module 

o Fit 8-pin and 4-pin female headers on the corresponding the male headers 

o Solder both female headers to the PCB. 

Test 3:  Turn the power on, as before, and observe the display.  The display backlight should turn on.  It 

might be difficult to see the backlight on an unlit display, so try sliding the switch on-and-off if the 

backlight is not immediately apparent.  Go the troubleshooting guide ƛŦ ȅƻǳ ŎŀƴΩǘ ǎŜŜ ǘƘŜ ōŀŎƪƭƛƎƘǘ. 

 

Using the display 

The LC meter display is a generic LCD 

module commonly known as the 

άMSP1803έ.  This is a 128x160 pixel TFT 

display mounted on a red carrier board, 

using the ST7735 driver and an SPI 

interface.  It is a 3.3V device.  Search 

Amazon and eBay ŦƻǊ άST7735 1.8έ ŀƴŘ 

you will find many vendors. The current 

price for the red Chinese no-brands, 

shown at right, is $7.   My display has 8 

pins on the right with a yellow header 

already attached.  On the left there is an 

additional row of 4 holes, without headers, 

for the SD card socket. 

To use this module, add the following library to your Arduino IDE: 

1. Go to the GitHub page: https://github.com/Bodmer/TFT_ST77355 

2. /ƭƛŎƪ ƻƴ ǘƘŜ Ψ/ƻŘŜΩ ōǳǘǘƻƴ ŀƴŘ ǎŜƭŜŎǘ ά5ƻǿƴƭƻŀŘ ½Ltέ 

3. Start the Arduino IDE and select Sketch > Include Library > Add .ZIP library 

4. bŀǾƛƎŀǘŜ ǘƻ ǿƘŜǊŜ ȅƻǳ ŘƻǿƴƭƻŀŘŜŘ ǘƘŜ ȊƛǇ ŦƛƭŜ ŀƴŘ ǎŜƭŜŎǘ άhǇŜƴέΦ  LŦ ǎǳŎŎŜǎǎŦǳƭΣ ǘƘŜ IDE status 

ƭƛƴŜ ǿƛƭƭ ǊŜǇƻǊǘ ά[ƛōǊŀǊȅ ŀŘŘŜŘ ǘƻ ȅƻǳǊ ƭƛōǊŀǊƛŜǎΧέ 

This display library is configured for our hardware by editing its User_Setup.h file: 

1. Go to the folder where the Arduino Libraries are stored.  For example, on my computer, the 

libraries are at C:\Documents\Arduino\Libraries 

2. hǇŜƴ ǘƘŜ ŦƻƭŘŜǊ ά¢C¢ψ{¢ттор-ƳŀǎǘŜǊέ  όƻǊ ¢C¢ψ{¢тторΣ ŘŜǇŜƴŘƛƴƎ ƻƴ ȅƻǳǊ ǎȅǎǘŜƳύ 

3. hǇŜƴ ǘƘŜ ŦƛƭŜ ά¦ǎŜǊψ{ŜǘǳǇΦƘέ ǿƛǘƘ ŀƴȅ ǘŜȄǘ ŜŘƛǘƻǊΦ  L ǳǎŜ bƻǘŜǇŀŘΦ 

4. Edit the following lines in the file, changing the values as shown. 

The 1.8" ST7735 display module (rear view) 

http://www.lcdwiki.com/1.8inch_SPI_Module_ST7735S_SKU:MSP1803
https://www.amazon.com/s?k=st7735+1.8
https://www.ebay.com/sch/i.html?&_nkw=st7735+1.8+TFT
https://github.com/Bodmer/TFT_ST7735


#define TFT_CS   10 
#define TFT_DC    9 
#define TFT_RST  - 1 

5. Save the file. 

Test 3, continued:  Apply ǇƻǿŜǊ ŀǎ ōŜŦƻǊŜΦ  DŜǘ ǘƘŜ ǎƪŜǘŎƘ άLCM_Test3έ ŦǊƻƳ GitHub and upload it to 

ȅƻǳǊ ōƻŀǊŘΦ  5ƻ ȅƻǳ ǎŜŜ ǘƘŜ ǿƻǊŘǎ ά{¢ттор Display ¢Ŝǎǘέ ƻƴ ȅƻǳǊ ŘƛǎǇƭŀȅΚ   You should see white-on-

black text, with a solid blue background, and no extraneous colors.  5ƻƴΩǘ ōŜ ŀƭŀǊƳŜŘ ƛŦ ƛǘ ƛǎƴΩǘ right the 

first time.  Most issues can be solved by editing the User_Setup.h file. 

Here is the sketch you just uploaded: 

#include "TFT_ST7735.h"                                // display library  
TFT_ST7735 tft = TFT_ST7735();                        // display variable  
 
void setup() {  
  tft.init();                                         // initialize the display  
  tft.setRotation(3);                                 // in landscape mode  
  tft.fillScreen(TFT_ BLUE);                           // with blue  background .  
  tft.drawString("ST7735 Display Test",10,20,2);       // add white - on- black text  
 
void loop(void) {}  
 

The first line, prefaced with άІƛƴŎƭǳŘŜέΣ Ǉǳƭƭs in the library that we just configured.  The next line 

instantiates the display variable άǘŦǘέ.  In setup(), there are a few lines to set landscape orientation and 

clear the display.  Finally, tft.drawString() is called to show text on the screen.   

 

Here is the display schematic. The 1K 

resistors R14-R17 allow us to use this 3.3V 

device with a 5V microcontroller.  Resistor 

R18 provides appropriate current limiting for 

the backlight LEDs.  Display pins 9-12, which 

connect to the onboard SD card, are not 

used in this project. 

 

  

Display Schematic 

https://github.com/bhall66/LC-meter/tree/main/diagnostics/LCM_Test3


Step 4a:  Add the control circuits. 

LǘΩǎ time to add a few buttons, LEDs, and 

relays.   For this section you will use 

components R10, R11, R2, D3, D4, S1, S2, and 

K2.  Install: 

o 1K resistors R10 and R11. 

o 120-ohm resistor R2. 

o LEDs D3 (yellow) and D4 (blue).  For both, 

the short lead goes to the square pad, so 

that the flat side of LEDs face left. 

o Tactile switches S1 and S2. 

o Reed relay K2, with the small body notch 

facing left. 

Test 4a:  Download sketch LCM_Test4 from 

GitHub.   Apply power & upload the sketch to 

the meter.   Press and hold S1.  LED D3 should 

flash while S1 is depressed.  Put your ear close 

to the reed relay and listen for the faint sound 

of its contacts opening and closing as D3 flashes.  Now press and hold S2 and observe LED D4. 

The 2 buttons and 2 LEDs are each tied to a microcontroller pin.   I like starting my sketches with a list of 

the pins and the devices they are connected to.    

#define C_KEY            3                            // D3: "KEY1" pushbutton  
#define L_KEY            2                            // D2: "KEY2" pushbutton  
#define C_LED            5                            // D5: LED for C_MODE  
#define L_LED            6                            // D6: LED for L_MODE  
 

Now we can refer to the interface components by name, rather than the pin they are connected to.  

Next, at the start of the sketch, each of these MCU pins is declared as an input or output: 

void initPorts() {                            // INITIALIZE MCU PINS  
  pinMode(L_KEY,INPUT_PULLUP);                // L pushbutton  
  pinMode(C_KEY,INPUT_PULLUP);                // C pushbutton  
  pinMode(C_LED,      OUTPUT);                // C LED  
  pinMode(L_LED,      OUTPUT);                // L KED  
}  

 

Note that the keys are on input pins and the LEDs are on output pins.  

INPUT_PULLUP means that the MCU internally applies a pullup resistor to the 

pin, ensuring that its value is logic 1 in the absence of any grounding input.  

Look at the schematic and notice that pressing S1 or S2 pulls its 

corresponding pin to ground.   

To check for key presses, one has only to check for voltage on the 

corresponding pin via digitalRead().  A depressed switch will be at logic 0. 

 

LC Meter Build: Step 4a 

https://github.com/bhall66/LC-meter/tree/main/diagnostics/LCM_Test4


Resistors R10 and R11 limit LED current and set their brightness.   To turn on the LEDs, the MCU applies 

5V to their corresponding pins via digitalWrite().  We can control both LEDs with a single routine: 

void setLEDs(int led1, int led2) {    // control the LEDs  
  digitalWrite(L_LED,led1);           // turn the L  LED on/off  
  digitalWrite(C_LED,led2);           // turn the C LED on/off  
}  
 

 

Step 4b:  Add more control circuits. 

For this section you will use components:  R1, D2, 

Q1, and K1.  Install 

o 1K resistors R1. 

o 1N4148 diode D2, with band facing LEFT. 

o NPN transistor Q1, with flat side facing LEFT. 

o DPDT relay K1. 

o DOUBLE-CHECK: D1 band LEFT, Q1 facing 

LEFT. 

Test 4b:  Apply power, using the same Test4 

sketch as before.  Press and hold S2.   Do you 

hear the DPDT relay?  It is louder than the reed 

relay.  If you hear it, set your DMM as a 

continuity tester/ohmmeter.  Place the black probe to the top 

pad of L1 and the red probe to one of the four pads on the 

άwŜŘέ ƧŀŎƪ WмΦ   tǊŜǎǎ ŀƴŘ ƘƻƭŘ S2 again.  The ohmmeter 

should beep and show a low resistance with the same timing 

as the flashing D2 LED. 

The partial schematic for both relays is at right. 

In the top part of the circuit, DPDT relay K1 is controlled by 

transistor Q1Φ  ²ƘŜƴ ǘƘŜ a/¦ Ǉƛƴ ά5t5¢έ ƛǎ ƘƛƎƘΣ ǘƘŜ ōŀǎŜ ƻŦ 

Q1 is also high, turning on Q1 and allowing current to flow 

through the relay coil, causing its contacts to close.  D2 is a 

άsnubber diodeέΣ ǇǊŜǾŜƴǘƛƴƎ ƭŀǊƎŜ ǾƻƭǘŀƎŜ ǎǇƛƪŜǎ ƻƴ ǘƘŜ 

power lines when the coil current collapses. 

Reed relay K2 is a low-current device, so it does not require a 

driver transistor.  Resistor R2 establishes a coil current of 

about 8 mA. 

 

  Relay Schematic 

LC Meter Build: Step 4b (closeup) 

https://en.wikipedia.org/wiki/Snubber


Step 5:  Build the oscillator. 

For this section you will use components L1, C1, C4, C7, R5-R9, R12, U2.  Install them in the following 

order: 

o Fixed inductor L1 and WIMA 2.5% film capacitor C1. 

o C4, the tantalum capacitor, with its (+) facing UP. 

o Resistors R9 (1K), R12 (6.8K) and R5-R6 (100K). 

o Resistors R8 (47K) and R7 (100K). 

o 10uF electrolytic cap C7, with the white stripe DOWN. 

o 8-pin DIP socket for U2, with the notch UP. 

o Insert U2 into its socket, with the notch UP. 

Test 5:  wŜǇƭŀŎŜ ǘƘŜ ŘƛǎǇƭŀȅΣ ŀǇǇƭȅ ǇƻǿŜǊΣ ŀƴŘ ǳǇƭƻŀŘ ǎƪŜǘŎƘ άLCM_Test5έΦ  ¢Ƙƛǎ ǎƪŜǘŎƘ ƳŜŀǎǳǊŜǎ ǘƘŜ 

ƻǎŎƛƭƭŀǘƻǊΩǎ frequency output.  It should display a frequency of about 500-600 kHz.  If so, press your index 

finger to the pads of red jack J1.   The added capacitance from your body should reduce the frequency of 

oscillation by roughly 10-20 kHz. 

U2, an LM311 comparator is 

configured as an oscillator.   The 

frequency-determining 

components of this oscillator are a 

coil L1 and capacitor C12, which 

resonate at approximately 600 kHz.   

The component under test is added 

to the LC tank -- either a coil in 

series with L1 or a capacitor in 

parallel with C12 -- and the new 

frequency is measured.  The 

change in frequency is 

mathematically related to the 

ǳƴƪƴƻǿƴ ŎƻƳǇƻƴŜƴǘΩǎ ǾŀƭǳŜΦ   ¢ƘŜ 

accuracy of this meter depends on 

internal calibration capacitor C2, 

which is nominally a 1000pF 

component with 1% tolerance. 

The LC meter works by measuring 

the oscillator frequency, calculating 

the unknown componentΩǎ value based on the frequency, and displaying the result on the LCD screen. 

  

Oscillator Schematic 

https://github.com/bhall66/LC-meter/tree/main/diagnostics/LCM_Test5

